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Further information, updates or software 
Visit our website via the following QR code or web link. Here you will find additional 
information, available updates or software for this product as well as suitable accessories: 

3D printer 

 
www.bresser.de/P2010600 

Accessories 

 
www.bresser.de/P2080210000000 

 

After Sales Support / Service 
For this product we offer an individual service even after the purchase. If you have problems 
with this product, our customer service will be happy to help you. 

For smooth processing, please have the following information ready for possible 
inquiries: 

• Warranty & Service 
• Part number and product description 
• Date of purchase and dealer 

 
Contact details: 
 
e-Mail:  service.3d@bresser.de   (preferred way of communication) 
Internet:  www.bresser.de/c/de/service 
Phone:  + 49 28 72  80 74 210 

Service hours: 

Monday thru Friday   9:00 a.m. to 3:00 p.m. (CET) 
(except on national holidays) 

*Number charged at local rates / amount you will be charged per phone call depends on the tariff of your phone provider / calls from abroad will 
involve higher costs 

 

Guarantee 
Please refer to the enclosed card "Warranty & 
Service" for further information.  
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Introduction 
 

Note: Each unit is subjected to a factory test before shipment. Residues on the 
extruder or the smallest of scratches on the construction tape are normal and have 
no influence on the print quality. 

Bresser GmbH would like to take this manual as an opportunity to thank both the 
technicians of Bresser GmbH and the users of this 3D printer for their tireless efforts 
and extremely important support. 

This Bresser GmbH Saurus user manual is intended for the users of Saurus who are 
now starting their journey into the future of printing with Bresser GmbH Saurus. Even 
if you are familiar with the older models of Bresser GmbH equipment or 3D printing 
technology, we recommend that you read this manual. It contains a lot of important 
information for you to know regarding Saurus and to improve your 3D experience: 

(1) BRESSER T-REX2 Quick Start Guide 

The Quick Start Guide is included with the printer. The information it contains will 
help you start printing in no time. 

(2) BRESSER T-REX2 product page on the Internet     

Visit the product page on the Internet at www.bresser.de/P2010600 for additional 
information, available updates or software for this printer and related accessories.  
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General Information 
 

Important notes: 
- - Please read this manual carefully before using the machine. 
- - This manual assumes that you are using the Windows 7 operating system to 

operate the 3D Printer.  
- - The current version of the REXprint software is used. 

This manual contains all necessary information for setting up and operating the 
device. 

The operating instructions consist of the following parts: Introduction, general and 
safety information, operation and product service. 

 

For service requests, please have ready: 

Item nr:  2010600 
Product reference BRESSER T-REX 2 3D Printer 
Instruction manual: 
Manual_2010600_Wifi-3D-Printer-T-REX-2_en_BRESSER_v112021a.docx 
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Safety Instructions 
IMPORTANT NOTE! 

Familiarise yourself with this manual and read all the instructions it contains before 
you start setting up and operating the machine. Failure to heed warnings and 
instructions may result in personal injury, fire, and damage to the unit or other 
property. 

STRICTLY FOLLOW ALL SAFETY AND OTHER INSTRUCTIONS GIVEN IN THIS 
MANUAL AT ALL TIMES! 

Safety in the working environment 
① Keep the workplace clean! 

② Do not operate the 3D Printer in the presence of flammable liquids, gases or 
dust. 

③ Keep children and untrained persons away from the 3D printer. 
 

Security of power supply 

① Operate the 3D Printer only from an earthed power outlet. Do not make any 
changes to the power plug of the 3D Printer. 

② Do not operate the 3D printer in a hazy or humid environment. Do not expose 
the 3D printer to direct sunlight. 

③ Do not use the power cable for any purpose other than its intended use. 

④ Do not operate the unit during thunderstorms. 

⑤ To avoid accidents, disconnect the device from the power supply if you are not 
going to use it for a long period of time. 

 

Safety of people 

① Do not touch the nozzle or pressure plate during printing. 

② Do not touch the nozzle after printing is completed. 

③ Wear suitable clothing. Do not wear loose clothing or loose-fitting jewellery. Make 
sure that your hair, clothing and gloves do not come into the vicinity of moving 
parts. 

④ Do not operate the device if you are tired or under the influence of drugs, alcohol 
or medication. 
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Safety Precautions 

① Do not leave the device unattended for a longtime. 

② Do not make any changes to the device. 

③ Lower the pressure plate before inserting/removing filament. (The distance 
between nozzle and pressure plate should be at least 50 mm) 

④ Operate the device in a well-ventilated environment. 

⑤ Do not use the device for unlawful purposes. 

⑥ Do not use the appliance to make containers for storing food. 

⑦ Do not use the device to manufacture electrical equipment. 

⑧ Do not put models in your mouth. 

⑨ Do not remove the models by applying force. 

  

Environmental conditions 

TEMPERATURE: Room temperature 15 to 30 °C ℃ 
Moisture: 20% ~ 70% 

 

Filament specifications 

Use the filament only for the intended purpose! Use only the BRESSER filament or a 
filament of the brands authorised by BRESSER! 

Filament storage 

A certain degree of decay can be observed in all polymers over time. Only unpack 
the filament when you need it. The filament should be stored in a clean and dry 
environment and protected from sunlight. 

 

Legal notice 

All information in this document can be extended or adapted without prior notice. 

BRESSER GMBH MAKES NO WARRANTIES WITH RESPECT TO THIS 
DOCUMENT, INCLUDING, WITHOUT LIMITATION, THE IMPLIED WARRANTIES 
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Furthermore, BRESSER GmbH does not assume any liability for errors contained in 
this manual or for incidental consequential damages in connection with the delivery, 
performance or use of this material. 
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EC DECLARATION OF CONFORMITY  
A "Declaration of conformity" in accordance with the applicable directives 
and corresponding standards has been prepared by Bresser GmbH. The 
full text of the EC declaration of conformity is available at the following 

Internet address: 

www.bresser.de/download/2010500/CE/2010200_CE.pdf 

 

EC DECLARATION OF CONFORMITY  
A "Declaration of conformity" in accordance with the applicable directives and 
corresponding standards has been prepared by Bresser GmbH. The full text 
of the EC declaration of conformity is available at the following Internet 

address: 

www.bresser.de/download/2010500/UKCA/2010500_UKCA.pdf 
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This document contains information protected by copyright. 

Copyright © 2020 BRESSER GmbH. All rights reserved.  

The reproduction of this documentation - even in extracts - in any form (e.g. 
photocopy, print, etc.) as well as the use and distribution by means of electronic 
systems (e.g. image file, website, etc.) without the prior written permission of the 
manufacturer is prohibited. 

The designations and brand names of the respective companies used in this 
documentation are generally protected by trade, trademark and/or patent law in 
Germany, the European Union and/or other countries. 
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Chapter 1: 3D printing technology 
 

3D printing transforms three-dimensional models into physical objects that you can 
touch and hold in your hand. This printing form is also called additive manufacturing, 
because the 3D model is created by applying as many layers as necessary until the 
object is completely formed. 

Fused Filament Fabrication (FFF) is the most common method of 3D printing used by 
this 3D printer. In this printing method, a plastic, the filament, is melted at high 
temperature and applied to a printing surface. The filament solidifies during cooling, 
i.e. practically immediately after leaving the nozzle. 3D objects are formed by 
applying the filament in several layers on top of each other. 

1.1 procedure 
3D printing involves three steps:  

1. Create or download a 3D model  
2. Slicing and exporting the 3D model 
3. Building the 3D model 

1.1.1 Creating a 3D model:  

There are currently three ways to create a 3D model: 

- Design from scratch You can use free computer-aided design (CAD) software 
such as 3DTADA, AutoCAD, SolidWorks, Pro-E or our own software Happy 3D to 
design your own 3D model.  

- 3D Scanner As an alternative to creating a 3D model, you can also scan an object. 
A 3D scanner digitalises  a physical object by capturing the object's geometric data 
and storing it in a file on the computer. It is also possible to use a mobile device as 
a 3D scanner by using an app. 

- From the Cloud - currently the most common method for obtaining a 3D model is 
to download a 3D model from a website where users can upload their own 3D 
models.  

https://cloud.sz3dp.com/ Bresser GmbH Cloud 

www.thingiverse.com Thingiverse is an active community for discovering, 
making and sharing 3D models. 
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1.1.2 Slicing and exporting a 3D model: 
Slicer software is used to prepare 3D models for printing and converting them into 
instructions for the 3D printer. REXprint is the slicer software for this 3D printer. With 
REXprint, STL files can be converted to G or GX files for printing. These are then 
transferred to the 3D printer via USB cable, USB stick or W-LAN. 

1.1.3 Structure of the 3D model 
After the output file is sent to the 3D printer, the printer begins to transfer the 3D 
model into a physical object by applying layers of filament over each other. 
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Chapter 2: About the 3D Printer 
2.1 About the 3D Printer 
Parts overview 

 
 

1. Platform 
2. Platform support 
3. Levelling nut 
4. LCD display 
5. Z-axis guide rod 
6. Extruder cable set 
7. X-axis guide rod 

8. Slit 
9. Nozzle cooling fan 
10.  Spring Retainer 
11. Cooling fan 
12. Nozzle 
13. Turbo blower plate 
14. Extruder holder 

15. SD card slot 
16. USB input 
17. Filament guide tube 
18. Bobbin holder slot 
19. Spool holder 
20. Power Input 
21. Power switch
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2.1.2 Accessories 
 

     
3D printer Filament spool Top cover Service card Quickstart Guide 

     
Power cable USB cable SD Card Spool holder Build tape 

     
Screwdriver Stamping wrench Allen key Pin tool Scraper 

     
PTFE tube Guide tube Grease Glue stick Anti-oozing plate 

  

   

Levelling 
-map 

Levelling nut    
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2.1.3 Terms and definitions 
 

Construction plate The surface on which BRESSER T-REX 2 builds an 
object. 

Construction volume The three-dimensional surface of an object after its 
completion. Largest construction volume of 
BRESSER T-REX 2: 200x148x150 mm. 

Levelling nuts Use the nuts under the platform to adjust the distance 
between the nozzle and the construction platform. 

Extruder The extruder pulls the filament from the spool, melts it 
and pushes it through a nozzle onto the construction 
platform. 

Nozzle This "print head" sits at the bottom of the extruder, 
there 
where the heated filament is pressed out. 

Filament guide tube A plastic tube in which the filament is fed from the 
filament box to the filament holder. 

Punch key A tool for determining the size of the nozzle metal 
cube. 

Cleaning pen tool A tool for cleaning the clogged extruder. 
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2.1.4 Device data 
 

Name BRESSER T-REX 2 3D Printer 

Number of extruders 2 (independent) 

Printing Technology Fused Filament Fabrication (FFF) 

Display size 8.9 cm (3.5")s 

Print volume 200 x 148 x 150 mm 
Mirror Mode: 80 x 148 x 150 mm 
Duplicate mode: 95 x 148 x 150 mm 

Layer resolution 0.1 mm 

Printing accuracy ±0.2 mm 

Printing filament PLA/PVA/ABS/HIPS 

Filament diametre 1,75 mm 

Nozzle diametre 0,4 mm 

Software REXprint 

Supported file formats Input: 3MF/STL/OBJ/FPP/BMP/PNG/JPG/JPEG 
GX/G 

AC input voltage Entrance: 100-240 VAC, 47-63 Hz, power: 320 W 

Connections SD card, USB cable, Bresser GmbH Cloud 

Operating system Windows XP/Vista/7/8/10、Mac OS、Linux 

Unit dimensions 526 x 360 x 403 mm 

Net weight 15 kg 
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2.2 Unpacking and installation 
Unpacking 
This chapter describes how to unpack completely the 3D Printer.  

Note:  
Please read the unpacking guide completely. 

1. Remove the packaging and carefully take out the contents. 
Do not use force. 

2. Do not remove the yellow high temperature tape around 
the nozzle. It exhibits thermal insulation and high 
temperature resistance properties. 

 
 

  

① Open the box and take out the foam 
parts. 

② Hold both handles on the two sides 
of the printer. Lift it out of the box 
and place it on a stable surface. 
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③ Remove the packing bag and 
remove the tape and the protective 
plastic cover of the front flap. 

④ The accessories are shown here. • 
Remove the package and take out 
accessories carefully! 

  

⑤ Remove the extruder and set it up 
carefully. The nozzle must not touch 
the table so that the nozzle remains 
protected from scratches 

⑥ Take out the foam with the accessories. 
Cut the two cable ties on both sides 
of the X-axis guide rod. 

  

⑦ Open the flap, remove the top cover 
of the printer and release the 
filament from the cover. 

⑧ Hold both sides of the pressure 
platform and lift the platform off the 
floor to make it easier to remove the 
foam box underneath. 
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⑨ Remove the foam from the bottom of 
the platform and then slowly push 
the platform down with your hands. 
This simplifies the subsequent 
installation. 

⑩ Now you have unpacked everything. 
Keep the packing material in case 
you need it again later. 
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INSTALLATION 
2.2.2.1 Extruder assembly 

① Lower the platform first. Then place the 
dual extruder on the extruder mount. 

② Take the M2.5 Allen Wrench from the 
tool bag and two M3 bolts from the 
accessory kit. 

③ Align the extruder with the screw holes. 

④ Screw the extruder to the extruder 
mount using the M3x screws. 

 
  

Screw hole Screw hole 
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2.2.2.3 Filament guide tube and insertion of the filament 

 
① For mounting a coil holder, level it. Then insert the end into the corresponding 

hole. 

 

② Turn the spool holder down so that the bottom gap of the holder sits at the back of 
the printer. 

 

③ Take a filament roll, squeeze the top of the spool holder and insert the filament 
spool into the holder. 
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Tips 
 
① The filament spool must be correctly 

aligned (see below). 

② After attaching the filament guide 
tube, push down the left spring 
retainer of the extruder. Then, from 
the other end of the filament guide 
tube, insert the filament vertically into 
the left filament holder. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: Please insert the guide tube fully into the spool to prevent the filament 
from twisting and wrapping around the outside of the spool. 

  

Filament guide tube 
Pipe clamp 

Limited uptake 

Attach the filament guide tube with the R-shaped 
clamps. 
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2.2.2.4 Assembling/Disassembling top cover 

Install the top cover for ABS printing; remove the top cover for PLA printing. 

 

 

2.2.2.5 Anti-oozing plate 

 
Fix the anti-oozing plate by two M3x8 screws. 

The nozzles must touch the moisture-repellent plate properly after installation. The 
distance between nozzle and plate can be adjusted by hand. After several printings 
scratches on the surface of the plate are normal. 

 

  



 

www.bresser.de  
 
 

24 

2.3 The initial setting 
Loading/Unloading filament 

     

① Tap the [Tools]-[Filament] button 

     

② Click the [Load] button. The extruder warm-up process begins. Once the target 
temperature has been reached, please feed the filament into the filament feed 
wheel by hand. When filament comes out of the nozzle, the loading process is 
complete. 

 

③ Tap the [Unload] button. The extruder warm-up process begins. Once the target 
temperature has been reached, feed some of the filament out of the nozzle by 
hand. Then push down the spring retainer, quickly pull out the filament and finish 
unloading. 
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Leveling 
To avoid levelling errors, the residual material must first be removed from the nozzle. 

     

① Tap the [Tools]-[Level] button to start levelling. The device first moves back to 
the home position. 

 

② After stopping movement of extruder and platform, tighten the three nuts below 
the platform counterclockwise. (This procedure is important to avoid scratches on 
the construction plate caused by the extruder). 

 

  

under 
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③ Choose one extruder and move it to the first nut by hand. Place a sheet of  paper 
under the extruder and tighten the nut to reduce the distance between extruder 
and platform. Gently move the paper and feel the friction. If the paper has only 
slight friction, the distance between the extruder and the platform is set correctly. 
After the adjustment of the first plate is completed, repeat the procedure for the 
second and third nut. 

Note: The short distance between extruder and platform makes it difficult to 
remove printed objects. Greater distances lead to bonding errors or wrapping. 
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2.3.3 XYZ axis calibration 
Z-axis calibration 

     

① Touch [Tools]-[Setting]-[Z Calibration]. The printer uses a compensation layer 
mechanism. The mounting positions of the right and left nozzles do not have to be 
adjusted by hand. A programme calculates the height difference between the two 
nozzles. 

     

② The extruder and the platform first move back to the zero position. Then select an 
extruder for calibration. If the temperature of the nozzle and platform is too high, 
the unit waits until the temperature has cooled down to 50 °C so that the nozzle 
does not burn the construction tape. 
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③ Follow the on-screen instructions and insert the levelling card between the nozzle 
and the platform. Adjust the distance using "Z-" and "Z+". The adjustment range 
refers to the levelling paper. As soon as you feel low frictional resistance, the 
distance between nozzle and platform is set correctly. After the first extruder has 
been calibrated, the switchover to calibration of the next extruder takes place. 

Note: Do not turn the nuts under the platform during Z-axis calibration. 

 

X-axis calibration 
X-axis calibration: Uniform adjustment of the two extruders in the direction of the X-
axis to avoid misalignment during printing. 

     

① When Z-axis calibration is complete, touch [Setting]-[X Calibration] or proceed 
to X-axis calibration. After the initialization movement of the device has been 
carried out, the nozzle and the platform are heated. Now make sure that the 
filament has been inserted into the extruder. 

 

② Once the warm-up phase is complete, the left and right extruders print a line one 
after the other. 
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③ Touch "X-", "X+" according to the printed lines to adjust the extruder deviations 
and remove the printed lines. Then touch the [OK] button. The two extruders (left 
and right) reprint the lines to check that they match. If they match, the X-axis 
calibration is complete. Otherwise, the adjustment must be continued until 
conformity is established. 

Y-axis calibration 

Y-axis calibration: Uniform adjustment of the two extruders in the direction of the Y-
axis to avoid misalignment during printing. 

     

① Finally, touch [Setting]-[Y Calibration] or continue to calibrate the Y axis after 
completing the X axis calibration. After the initialization movement of the device 
has been carried out, the nozzle and the platform are heated. Now make sure that 
the filament has been inserted into the extruder. 

 

② Once the warm-up phase is complete, the left and right extruders print a line one 
after the other. 
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③ Touch "Y-", "Y+" according to the printed lines to adjust the extruder deviations 
and remove the printed lines. Then touch the [Verify] button. The two extruders 
(left and right) reprint the lines to check that they match. If they match, the Y-axis 
calibration is complete. Otherwise, the adjustment must be continued until 
conformity is established. 
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First print 
After mounting, loading the filament and calibrating, start your first print. 

 

① Insert the SD card into the side of the device. 

         

 
② Touch [Print]-[SD card] and select the test file for printing. 
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2.3.5 Remove model 
Hot! Lower the platform first before removing the model. Pay attention to the 
removal direction to avoid scratches caused by the scraper blade. 

The construction plate must not be damaged during the removal of the model. 
Scratches on the construction plate can cause printing errors. 

 Cooling of the model 
The model is printed without glue on the construction plate. After the printed 
objects and the construction plate have cooled down, the models can be 
easily removed. 

 
 Use of the scraper blade 

After cooling, the printed object continues to adhere to the platform. It can be 
detached from this with the help of the spatula. Hold the blade parallel to the 
printing platform and carefully insert it at the bottom of the model. Then 
remove the model using little force. 
 

2.3.6 Removing supports 
The PVA supports are removed after processing. Place the PVA supports in water to 
loosen them from the model. 

① Place the printed objects in water. 
Place the printed objects with the PVA supports in water to loosen the PVA 
supports. There are a few ways to speed up the dissolving process. 

 The use of warm water speeds up the dissolving process. If the main structure 
of the printed objects is PLA, the water temperature must not exceed 35° C. 
Otherwise the printed model will be deformed. 

 Stir the water. Stirring can accelerate the dissolution of the PVA. 
 Soak the printed objects in water for about 10 minutes. Then remove the 

supports with pliers. Place the printed objects in water to dissolve PVA 
residues. 

 

② Rinse with water 
After the PVA support is completely dissolved, wash the object with water to 
remove the remaining PVA. 

③ Dry model 
Allow the model to dry completely and continue working on the object if 
necessary. 

④ Waste water disposal 
PVA is biodegradable and therefore the waste water can be disposed of without 
any problems. After the wastewater has been disposed of, wash the object with 
hot water for 30 minutes to remove residual PVA from the drain pipe so that 
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blockages are avoided. The water can be used several times to soak several 
objects in it. However, the resolution time may be extended. Therefore, it is 
recommended to use fresh water, because then the best effect can be achieved. 
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2.3.7 Material compatibility 
The printer has two independent extruders and supports PLA, ABS, HIPS and PVA. 
Combo mode: 

PVA+PLA HIPS+ABS PLA+PLA ABS+ABS 

BRESSER materials give the best results, but BRESSER T-REX 2 also supports the 
use of other brands of materials. All BRESSER materials have been tested. The best 
test results were achieved with REXprint. 

PVA filament is water soluble and has strong water absorbing properties. The 
filament may become soft after absorbing water, which may cause misprints. Place 
the PVA filament in a dry box during printing. PVA must be kept  closed tightly and 
dry. 

To achieve the best results, the appropriate settings must be made for each material. 

When REXprint is used to slice the model, these settings are made automatically 
when the correct extruder and suitable material are selected. 

Adjustment of material parametres 
Different brands of filament have different material properties. Therefore, it is 
recommended to use the expert mode to fine-tune the parametres so that a good 
print quality is guaranteed. 

 Determining the thickness of the first layer adhesion to the platform improves 
when the first filament layer is applied. 

 Set the platform temperature for printing small PLA models at 30°C or 
whenever the ambient temperature exceeds 25°C. 

 Set the platform temperature for printing large PLA models at 50° C, or 
whenever the ambient temperature falls below 10° C. 

 The open pressure chamber is suitable for PLA prints. Remove the top cover. 
 The closed pressure chamber is suitable for ABS prints. Close the top cover to 

prevent the filament from breaking. 
 It is recommended to reduce the normal printing speed by 40°%. Place the 

PVA filament in a dry box so that no water is absorbed from the air, which can 
cause misprints. 
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2.4 Touchscreen Interface - Introduction 
Print surface 

     

 

① Insert the SD card to the side of machine. During printing, the SD card must be 
inserted into the printer, regardless of whether you are printing from the SD card 
or connecting REXprint via a USB cable. 

      Touch [Print]-[SD Card] and select the files to print. 

     

② To change the temperature, touch the extruder or platform temperature display on 
the touchscreen. 
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③ Touch [More] to pause printing or to replace the filament during printing. 

Preheat surface   

     

① Touch [Preheat] to preheat the extruder or platform. Set the target temperature 
by touching it on the touchscreen. 

 

② Touch [Stop] to stop the warm-up. Touch the black arrow to return to the main 
window. As soon as the desired preheating temperature is reached and if no 
further entries are made, the preheating process stops. 
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Tool surface 

     
The tool interface contains the Filament, Level, Home, Manual, Setting, Status, 
and About tabs. 

 

     
[Filament] 
Filament load and unload settings. 

 

     
[Level] 
The flatness of the platform is adjusted manually. 
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After stopping movement of extruder and platform, tighten the three nuts below the 
platform counterclockwise. (This procedure is important to avoid scratches on the 
construction plate caused by the extruder) 

     
Choose one extruder and move it to the first nut by hand. Place a sheet of  paper 
under the extruder and tighten the nut to reduce the distance between extruder and 
platform. Gently move the paper and feel the friction. If the paper has only slight 
friction, the distance between the extruder and the platform is set correctly. After the 
adjustment of the first plate is completed, repeat the procedure for the second and 
third nut. 

     
 

under 
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[Manual] 
Touch the touch screen for XYZ axis movement control. 

 

 
Setting 
The "Setting" interface includes "X Calibration", "Y Calibration", "Z Calibration", 
"Expert Mode", "Language" and "FactoryReset". 

 

 
[X Calibration, [Y Calibration], [Z Calibration] 

For further information, please refer to chapter 2.3.3. 
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[Expert mode] 
Simplified calibration for experienced users in expert mode. The placement of the 
extruder on the X or Y axis can be adjusted according to the deviation value of the 
model printed by two extruders on the same axis. 

 

     
If the left extruder prints to the right on the X axis, touch [X-]. If the left extruder prints 
to the left on the X axis, touch [X+]. 

When the right extruder is printing to the left on the Y axis, touch [Y-]. When the right 
extruder prints to the right on the X axis, touch [Y+]. 

 

     
[Language:] 
Support: Chinese, English, Japanese, German, French and Spanish. 
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[Factory settings] 

After touching, all values are reset to the factory settings. 

 

 
[Status] 

Under "Status" the extruder and platform temperature as well as the coordinates of 
the XYZ axis are displayed. Touch the light status bar. The ambient light in the 
chamber of the device changes according to the settings. 

 

 
[Info] 
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The basic device information is displayed. The information displayed varies 
depending on the current device. 

The firmware version of the device, the print volume, the total print time, etc. are 
displayed here. 

 
Note: Always quote the serial number when contacting customer service. 

 

 

[Firmware Upgrade] 

Method 1: 

Insert the SD card into the computer and create a folder named "sys". Copy the 
firmware files to the "sys" folder. Then insert the S-card into the device. Switch on the 
device and update the firmware. After updating the firmware, delete the "sys" folder. 

Method 2: 

Update the firmware via USB cable with REXprint. 
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Chapter 3: Slicing Software 
 

Using the slicing software REXprint, .stl and .obj files are converted into .g files that 
can be printed with BRESSER T-REX 2. 

3.1 Installation 
3.1.1 How do I get REXprint? 
There are two ways to get the REXprint software: 

Method 1: Download the installation package from the SD card in the accessory kit. 

Method 2: Download the latest version from the Download Center on the Bresser 
product website www.bresser.de/P2010600. 

Getting Started 
Extract the zip file or run the installer. Install the software according to the 
instructions. 

Start the software with Start menu keyboard shortcut by touching the software icon. 
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3.2 Get to know REXprint 
Note: 
BRESSER T-REX 2 supports printing from REXPrint via USB cable. 

3.2.1 Selection of the device type 
Attention! After starting REXPrint, you must first select the device type. 

A dialogue box opens when you start REXprint. Select BRESSER T-REX 2 from the 
list of displayed device types and tap [OK]. You can also change the machine type 
by touching [Print]-[Machine Type]. See the figure below: 
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3.2.2 Presentation of REXPrint 

 
 

 
Load 
Load only one file at a time  

Supports (Support) 
Open prop editing mode. 

 
Printing (Print) 
Print directly with the BRESSER 
T-REX 2 or export to a USB stick 

 
View (View) 
View FlashPoint home screen, 
from one of six angles 

 
Move 
Move the model on the XY axis. For the movement on the Z-axis 
"Shift+click". 

 
Rotate 
Rotate and turn your model.  

Scaling 
Size scaling of your object 

 
Cutting (Cut) 
Cut the model into several parts  

Extruder 
Select the left or right extruder 
before setting the parametre 
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3.2.3 Loading 
You can use the following six methods to load a model or Gcode file into REXprint: 

Method 1:  Touch the [Load] icon on the main interface.  

Method 2:  Then select the object file. Select the file you want to load and drag it 
to the main interface of the software. 

Method 3:  Touch [File]--[Load File]. Then select the object file to be loaded.  

Method 4:  Touch [File]--[Examples] to load the example files. 

Method 5:  Touch [File]--[Recent Files] to open the previously loaded files.  

Method 6:  Select the destination file, touch it and drag it to the REXprint icon. 

Note: 3D models can be saved as .STL, .OBJ or .FPP files and processed with 
REXPrint. 

 

Enhanced: Designing reliefs 

  
Shape: includes the shapes "Plane", "Tube", "Canister" and "Lamp". 
Fashion: Includes "darker is higher" and "lighter is higher". 
Maximum Thicknes: Z-value of the model 
Base Thickness: The minimum raft thickness: Default value 0.5 mm. 
Width: X-value of the model 
Depth: Y-value of the model 
Bottom Thickness: Determination of the base thickness for the "Tube", "Canister", 
Seal" and "Lamp" moulds. 
Top Diametre: Determination of the upper diametre for the shapes "Tube", Canister" 
and "Lamp". 
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Bottom Diametre.Determination of the bottom diametre for the shapes "Tube", 
Canister" and "Lamp". 
 

Plane Tube/Canister 

 

 

Lamp (6-8) Seal (6-9) 
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3.2.4 Views 
① Changing views 

Change the model views by moving, rotating and scaling. 

● Pulling 

Click on the [View]  icon. The object can then be moved using one of the 
following three methods: 

Method 1: Drag the mouse while holding down the left mouse button. 

Method 2: Drag the mouse while holding down the middle mouse button. 

Method 3: Drag while holding down the Shift key and right mouse button.  

● Rotate 

Click on the [View]  icon. The object can then be rotated using one of the 
following two methods: 
Method 1: Hold down the right mouse button and drag. 
Method 2: Hold down the Shift key and left mouse button and drag. 

● Scaling 
Turn the mouse wheel to enlarge or reduce the printing plate.   
 
② Set the view 
The user can view the object on the printing plate. There are six views available in the 
View menu, i.e. the home view, the view from below, from above, from behind, from 
the front, from the left and from the right.  
Method 1: Click the [View]  button. The drop-down list then lists six views.  

Method 2: Click on the  [View] button and then click again to open a submenu 
with the six views available for selection. 
 
③ Reset the view 
There are the following two ways to reset views: 
Method 1: Click the [View] menu and select [Home View]. 

Method 2: Click the  [View] button on the left, and click it again to display the 
display options. You may then click on [Reset]. 
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④ Display the model outline 

Click  [View] > [Show Model Outline]. The yellow outline of the object is then 
highlighted. 

 

⑤ Display of a steep overhang 

Click  [View] > [Show Steep Overhang]. If the angle of intersection between the 
model surface and the horizontal line is within the range of the overhang threshold, the 
surface has a steep overhang and is displayed in red in the software. The threshold 
value for the overhang can be adjusted as required. By default the value is set to 45°. 

 

3.2.5 Moving 
Select the desired object and move it using one of the following two methods: 

Method 1: Left click on the  [Move] icon, hold down the left mouse button and 
drag to move the position of the model in the XY direction. Hold down the Shift key and 
left mouse button and drag to move the position of the model in the Z direction. The 
distance and direction of movement are displayed. 

Method 2: Click the  [Move] button on the left, and then enter a value for the 
distance. Click [Reset] to reset the distance values. 

Note: After adjusting the position, you should click [Centre] and [On Platform] to 
ensure that the models are in the print area and on the print platform. If a specific 
position is required, click only [On Platform]. 
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3.2.6 Turning 
Select the desired object and rotate it using one of the following two methods:  

Method 1: Click the  [Rotate] icon on the left. Three rings at right angles to 
each other are then displayed around the object. Click on a ring and make a rotation 
around the current axis. You can then see the angle of rotation and the direction in 
the middle of the ring. This allows you to rotate the model around the X/Y/Z axes. 

Method 2: Click the  [Rotate] icon on the left, and then enter the rotation angle 
values for positioning for the X/Y/Z axes. Click  [Reset] to reset the rotation angle 
values. 

 

3.2.7 Scaling 
Select the desired object and scale it using one of the following two methods:  

Method 1: Click on the symbol  [Scale] on the left, keep the left mouse button 
pressed and scale the model. The corresponding values are displayed next to the 
object. 

Method 2: Click the  [Scale] icon on the left, and then enter the positioning scale 
values for the X/Y/Z axes. Click the  [Maximum] button to achieve the maximum 
possible size for printing. Click  [Reset] to reset the size of the model. 

Note: If you clicked the [Uniform Scaling] radio button, the model will be scaled to 
scale when you change any value of the model's positioning. Otherwise, only the 
corresponding item value is changed. 
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3.2.8 Cutting 

Left-click the model to select it, then double-click the "Cut" icon  to set the cut 
plane. You can set the direction and the position. 

① Draw with mouse 

 

 

 

 

 

 

② X plane 

 

 

 

 

 
③ Y-plane 
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④ Z-level 

 

 

 

 

 

 

Extruder  
There are right and left extruders. First select the model. Click on the extruder icon. 
The extruder settings menu is displayed. Before starting the printing process, the left 
or the right extruder must be selected. 
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3.2.10 Supports  
After you have loaded the model, click on [Edit] > [ Supports] or directly on the  

Supports icon . You then switch to the editing mode for supports (as shown in 
the figure below). Click [Back] to exit this mode when you have finished editing. 

 

① Support options 

When you click on "Support Options", a radio button is displayed listing the support 
options "Treelike" and "Linear". If you select the "Treelike" option and click [OK], a 
tree structure is created. However, if you select "Linear" and then click [OK], a linear 
structure is created. If the model already has supports and you select one of the 
support options, the software will assess whether the existing supports need to be 
deleted. This decision is made on the basis of the type of support selected. You can 
confirm this decision in a pop-up window. 
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② Automatic supports 
Click the [Auto Supports] button. The software evaluates the positions where 
supports are required and creates corresponding supports in tree format or linear 
format. For a model with supports, the existing supports are removed and new ones 
are created. 

③ Adding supports 
Supports are added when you click the [Add] button. Position the mouse pointer at 
the point where a support is required, click the left mouse button to select the starting 
point for the support, hold down the left mouse button and drag the mouse. The 
column preview opens (if no column is required for the area or if the angle of the 
column is too large, this is highlighted in the column view). Release the left mouse 
button. If the support column is not suitable for a model, the support is created at the 
starting and end points (the highlighted support in the preview does not create a 
support structure). 

④ Removing supports 
Click on [Clear Supports]. All supports are then deleted. You can cancel this 
deletion processby clicking on [Undo] or by pressing the key combination Ctrl+Z. 
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⑤ Deleting supports 
Supports are deleted when you click the [Delete] button. Position the mouse pointer 
on the column to be deleted. The current column and its subnodes are highlighted. 
Press the left mouse button to delete the highlighted support. 

 

3.2.11 Printing 
Click the print icon. Now the print screen is displayed. After all parametres have been 
set, click [OK]. Then select the correct file format and click [Save]. 
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Preview: Open or do not open the preview interface. Selecting this option 
automatically displays the preview after slicing is complete. Slide 
the model layer slider on the left side of the interface up and 
down to display the model layer. The estimated print time for the 
model and filament are displayed in the upper right corner. Click 
[Print] to connect the machine. Click [Back] to display the main 
interface again. 

Materials: ABS/PLA 

Supports: A support is required for printing off/on models. Clicking 
[Support] creates a support part for the print. 

Raft: With the help of this function, the model adheres well to the 
platform. 

Wall During dual color printing, this feature protects against contact 
with filament exiting another extruder. 

Brim: Expansion of the bottom layers of the model so that the edges of 
the model are anchored to the platform in such a way that it 
does not warp or the pressure fails. 

Resolution: There are three resolutions (including the default): high 
resolution corresponds to a slow print speed, low resolution to a 
fast print speed. The "Hyper" function is available for PLA 
printing. 

More Options: Under [More Options], settings can be made for "Position", 
"Layer", "Infill", "Speed" and "Temperature". The different 
resolutions according to the different default settings. To restore 
the default settings, click [Restore Defaults]. 
 

 
 

Layer height Layer Height: Layer thickness of the print 
model. The smaller the value, the smoother 
the surface of the model. 
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 b. First Layer Height: This first layer of the 
model influences the adhesion performance 
between model and platform. The maximum 
value is 0.4 mm. Normally the default value 
is sufficient. 

Shells This includes the outer shell value, the cover 
layer value (under a vase pattern; the upper 
robust layer setting is invalid. 
Perimetre Shells: Maximum is 10 
Top solid layer: Maximum is 30, minimum 
is 1 
Bottom solid layer: Maximum is 30, 
minimum is 1. 

Infill Fill Density: Fill rate. 
Fill Pattern: The pattern of the filling mold. 
This has an influence on the printing time. 
Combine infill: The layers for the 
combination can be selected according to 
the layer thickness. The combined thickness 
should not exceed 0.4 mm. "All n layers" 
refers to all layers. "All n inner layers" only 
affects inner infills, i.e. the printing time is 
shortened. 

Speed Print Speed: The extruder movement 
speed. Generally speaking: The lower the 
print speed, the better the print result. 80" is 
recommended for PLA printing. 
Travel Speed: Control of the movement 
speed of the extruder without printing. 100" 
is recommended for PLA printing. 
Note: The parameter settings can be 
adjusted accordingly for different 
models. 

Temperature Extruder temperature: Recommended 
extruder temperature: 220°C Note: The 
different temperatures influence the printing 
process. The temperature must be adapted 
to the prevailing conditions in order to 
achieve a good printing result. 
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Platform Temperature: Determination of 
the platform temperature. 

Others Cooling Fan Control: Setting up the time 
period until the cooling fan is switched on. 
You can set the value in advance, then the 
cooling fan will be activated when this point 
is reached. 
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3.2.12 File menus 
① New Project 
Click at [File] > [NewProject] to create an empty project. If a change has not yet 
been confirmed for a previous project, you will be asked whether or not to save the 
change. Click [Yes] to save the change or [No] to discard it. If you click [Cancel] or 
close the tooltip, the new project is not created. 

 
 
② Save 
After the model has been edited and adjusted, there are two ways to save all the 
models displayed. 

Method 1: Click on [File]--[Save Project] to save the file as project file with the file 
name extension FPP. All models shown (including supports) remain independent of 
each other. When the file is re-loaded, the configuration information for the extruder 
and model positioning will be the same as the configuration when the file is saved. 

Method 2: Click [File] > [ Save as...] to save the model as a project file in FPP, STL 
or OBJ format. With the STL and OBJ file formats, the models are integrated into a 
single model (including the supports). When re-loading these file formats, only the 
position of the model is saved, but not the print parametres. 
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③ Preferences 
Click on [File] > [ Preferences] . Here you can select the language and define the 
search for existing updates at device startup. 

 
● Language: The software supports the following six languages: Chinese (simplified 
and traditional), English, French, Korean, Japanese and Russian. 

● Printing Window Type: Includes basic mode and expert mode  

● Check for Update After Start Up: This setting allows you to specify whether 
automatic online updating should be activated. If you select "Yes", the software can 
check online each time it is started to see if a new software version is available and, 
if so, prompt the user to download and install the new software version. 

 

3.2.13 Editing menu 
① Undo 
The following two options are available to cancel the last changes made: 

Method 1: Click at [Edit] > [Undo].  

Method 2: Press the key combination Ctrl+Z.  

② Redo 
The following two options are available to restore the last undone change to the 
model file. 

Method 1: Click to [Edit] > [Redo]. 

Method 2: Press the key combination Ctrl+Y. 

③ Empty Undo Stack 
You can use this function to delete the stored processing steps to free up memory 
space. 
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④ Select All  
The following two methods can be used to select all models in the editing 
environment. (If models are so small that you cannot see them, or are outside the 
viewport, click the [Center] and [Scale] buttons to adjust the model) 

Method 1: Click at [Edit] > [Select All]. 

Method 2: Press the key combination Ctrl+A. 

⑤ Duplicate 
Duplicate the object using one of the following two methods: 

Method 1: Click on [Edit] > [Duplicate]. 

Method 2: Press the key combination Ctrl+D. 

⑥ Delete 
Delete object using one of the following two methods: 

Method 1: Click on [Edit] > [Delete]. 

Method 2: Press the Del key. 

⑦ Surface to Platform 
After you have selected the model, you can use the following procedure to place the 
model surface on the platform. 
Click [Edit] > [Surface to Platform] to switch to Surface to Platform mode  
(as shown in the following figure).  
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⑧ Auto Layout All 

Click [Edit] > [Auto Layout All] after you have loaded one or more models. All 
models are then positioned using the automatic placement rule. 

 

3.2.14 Tool menus 
FIRMWARE UPDATE 
Open REXPrint (your computer and the printer must be connected via a USB cable). 
Click [Tools] and [Update Firmware], and then click [OK]. A dialogue box is 
displayed. Click [Yes] to start the firmware update. 

 

3.2.15 Help menu 
① Initial execution assistant 
Here the basic functions are briefly introduced. 

② Help contents 
Clicking [Help]-[Help Contents] displays the help contents. 

③ Check for updates 
Clicking [Help]-[Check for Updates] will check for available online updates. 

③ About REXprint 
Clicking [Help]-[About REXprint] displays the software info window. The current 
software version and copyright notices are displayed here. 
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3.3 How do I create a .g file? 
By default, the left extruder is used as the material extruder; the right extruder is the 
printing extruder. When printing a monochrome model, the right extruder is 
automatically set as the print extruder unless this setting is changed by the user. 
 

 
① Click [Print]-[Machine Type] for the printer model selection. 
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② Click the [Load] icon to load an STL model file. The object is displayed in the 
construction area. 

 

Preview: Check the function recommend. 
Machine type: BRESSER T-REX 2. 
Materials: Select the desired materials. 
Supports: Recommended setting [Enable]. 
Raft: Recommended setting [Enable]. 
Resolution: Recommended setting [Default]. 
More Options: It is suggested that you keep 
the default settings. 
 
Note: The default settings are good for first 
time users. 
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3.4 Introduction to functions 
Expert mode 
① Click [File] on the menu and select [Preferences]. Select "Expert Mode" in the 
pop-up window and click [OK]. 

 
 

② Click the [Print] icon on the REXprint interface. The parametre settings window is 
displayed. Select the materials, including Creator Pro 2 PLA. For printing with 
water-soluble supports, click [General]-[Adapt Soluble Support Filament]-
[PVA]-[Adapt], and then click [Save Configuration]. 

The expert mode supports the selection of soluble materials. Click on it and set the 
feed for the left extruder. It depends on the material properties whether the feed has 
to be adjusted. The feed setting can reduce drawings. 
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The distance between supports and model and the support density can be adjusted 
in the [Supports] setting tabs. 
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Mirror/duplicate functions 
Print two identical models, select duplicate mode; print two mirror-like models, select 
mirror mode. 

In "mirroring" or "duplicating" mode, two extruders print the models simultaneously. 

Note: The size of the X-axis of the model should be less than 80 mm in mirror 
or duplicate mode. 

 

① Select Model and click [Extruder] to start setting the extruder. 
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② After the executed mirroring or duplicating, the models are displayed in the build 

area. Tap [Print]. Due to the difference in height of the two extruders in mirroring 
mode, a compensation layer may be printed. Therefore, it is recommended to add 
"Raft" in the mirror mode.  
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Add supports 

Adding supports for off/on structures for a good print result. 

 

 
① Click the [Supports] icon to make the settings for the supports. The 
prop settings can be made automatically. Click [Delete] on the left side 
to delete the supports manually. 
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② Under [Support Options], select 
tree shape or linear supports. 
Overhang threshold refers to the 
angle of the up/down suspended 
model. If the angle is exceeded, the 
support is generated. 

③ Click [Auto Supports] to create 
supports automatically. 
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Dimensional adjustments 

 
For dimensional deviations, click [Others] to open the dimensional adjustment 
functions. Positive adjustments of values produce enlargements, negative 
adjustments produce reductions. The Z-axis height is adjusted according to the 
percentage value.  
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Chapter 4: Maintenance 
 

Problem Cause Remedy 
Extruder head off-centre The device no longer recognizes 

the exact extruder position and 
cannot build. 

Return the extruder to the home 
position to recalibrate the 
BRESSER T-REX 2. Abort your 
object, empty the construction 
platform, send the extruder to the 
home position and restart your 
object. 

No PLA extrusion or adhesion to 
the construction tape. 

This may be due to the platform and 
extruder head not being properly 
aligned (levelled). 

By levelling the platform, the 
extruder head is aligned, which 
improves the quality of the object. 
Abort your object, empty the design 
platform, level the extruder in the 
home position, and restart your 
object. 

BRESSER T-REX 2 frozen 
before object start. 

BRESSER T-REX 2 may receive 
contradictory commands. 

Turn off the power switch, wait 30 
seconds, and turn on the power 
switch. 

Entanglements at the end of the 
construction. 

A layer of your object is not 
adhering properly, the model was 
secured to the construction 
platform with minimal contact, or 
the object was built floating and 
without supports above the 
construction platform. Wrong Z-axis 
offset, extruder tip is not aligned 
with the correct distance to the 
design platform. 

Use the preview function of your 
slicing software to display the 
height and position of the first layer. 
Build with supports if necessary. 
For information on calibrating the Z-
axis offset, contact Customer 
Service. 

No filament leaks. Extruder clogged. Filament not 
loaded properly. 

Try changing the filament to make 
sure the extruder gears have 
gripped the filament properly. 
Contact customer service. 

Extruder not in home position. Limit switch wiring Contact customer service. 

Straggly or frayed plastic layers 
on steep overhangs. 

Object overhangs are too far apart 
or too steep (angle less than 45 
degrees). 

Building with supports. 
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Chapter 5: Warranty and service 
 

Warranty 
The regular guarantee period is 5 years and begins on the day of purchase.  

Please keep the proof of purchase (receipt/invoice) carefully as proof of purchase. 

During the warranty period, defective devices will be accepted by the local dealer or, 
if necessary, sent in directly by you. In any case, the postage costs must be at your 
expense. In case of a warranty claim, the postage costs will be refunded. You will 
then receive a new or repaired device back free of charge. The decision whether to 
repair or replace the device is up to us. 

Excluded from this warranty are accessories/components such as mounting plates 
and foils, acrylic glass/plastic elements, USB/removable storage media, filaments 
and coils, adhesives, resins/greases, vessels and containers, tools etc. 

The guarantee expires if defects in the object of purchase are due to the following 
circumstances: 

 improper usage 
 negligent or intentional damage through own fault and/or unauthorized third parties 
 Repairs or alterations carried out by third parties without our order 
 Changes or damage due to force majeure (storm, hail, fire, power failure, lightning, 

flooding, snow damage, frost and other effects caused by animals, etc.) 

The warranty is also void if a damaged and/or illegible or incomplete proof of 
purchase is presented. 

The rights from the guarantee exist independently of the legal warranty claims. 

The guarantor is BRESSER GmbH, Gutenbergstr. 2, 46414 Rhede, Germany. 

After the warranty period has expired, you also have the possibility to send a 
defective device for repair. Repairs after the warranty period are subject to a charge. 
You will receive a cost estimate from us before the repair is carried out. 

  



 

www.bresser.de  
 
 

74 

In case of a return, please note the following: 

Make sure that the article is sent carefully packed. If possible, use the original 
packaging. Fill out the Service Form and enclose it with the proof of purchase. 

 

Service 
You can contact the BRESSER service team if you have problems with the 3D 
printer. If questions or problems are not covered in this manual, you can search for 
solutions on our official website or contact us by phone. 
Our Knowledge Base provides solutions and instructions for frequently occurring 
problems. It is advisable to look for a solution there first, as the most frequent 
questions are answered there. 
http://www.bresser.de   
Email: service.3d-printer@bresser.de 
You can reach the BRESSER service team by phone or e-mail from Monday to 
Saturday, 8:30-15:30 (CET). If you contact us outside these business hours, we will 
answer your request on the following working day. 
Note: Due to different filaments the extruder can be blocked. This problem is 
not a quality problem and is outside the range of 400 hours of operation. If this 
problem occurs, please contact customer service and carry out cleaning 
according to the instructions provided there. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



DE   AT   CH   BE
Bei Fragen zum Produkt und eventuellen 
Reklamationen nehmen Sie bitte zunächst mit 
dem Service-Center Kontakt auf, vorzugsweise 
per E-Mail. 

E-Mail: service@bresser.de
Telefon*: +49 28 72 80 74 210

BRESSER GmbH
Kundenservice
Gutenbergstr. 2
46414 Rhede
Deutschland
*Lokale Rufnummer in Deutschland (Die Höhe der Gebühren je 
Telefonat ist abhängig vom Tarif Ihres Telefonanbieters); Anrufe aus 
dem Ausland sind mit höheren Kosten verbunden.

GB   IE
Please contact the service centre first for any 
questions regarding the product or claims, 
preferably by e-mail.

E-Mail:  service@bresseruk.com 
Telephone*: +44 1342 837 098

BRESSER UK Ltd. 
Suite 3G, Eden House 
Enterprise Way 
Edenbridge, Kent TN8 6HF 
United Kingdom
*Number charged at local rates in the UK (the amount you will 
be charged per phone call will depend on the tariff of your phone 
provider); calls from abroad will involve higher costs.

FR   BE
Si vous avez des questions concernant ce produit 
ou en cas de réclamations, veuillez prendre 
contact avec notre centre de services (de 
préférence via e-mail).

E-Mail:  sav@bresser.fr 
Téléphone*: 00 800 6343 7000

BRESSER France SARL 
Pôle d’Activités de Nicopolis 
314 Avenue des Chênes Verts 
83170 Brignoles 
France
*Prix d'un appel local depuis la France ou Belgique

NL   BE
Als u met betrekking tot het product vragen 
of eventuele klachten heeft kunt u contact 
opnemen met het service centrum (bij voorkeur 
per e-mail). 

E-Mail: info@bresserbenelux.nl 
Telefoon*: +31 528 23 24 76

BRESSER Benelux 
Smirnoffstraat 8 
7903 AX  Hoogeveen 
The Netherlands
*Het telefoonnummer wordt in het Nederland tegen lokaal tarief 
in rekening gebracht. Het bedrag dat u per gesprek in rekening 
gebracht zal worden, is afhankelijk van het tarief van uw telefoon 
provider; gesprekken vanuit het buitenland zullen hogere kosten met 
zich meebrengen.

ES   IT   PT
Si desea formular alguna pregunta sobre el 
producto o alguna eventual reclamación, le 
rogamos que se ponga en contacto con el centro 
de servicio técnico (de preferencia por e-mail).  

E-Mail: servicio.iberia@bresser-iberia.es 
Teléfono*: +34 91 67972 69

BRESSER Iberia SLU 
c/Valdemorillo,1 Nave B 
P.I. Ventorro del Cano 
28925  Alcorcón Madrid 
España
*Número local de España (el importe de cada llamada telefónica 
dependen de las tarifas de los distribuidores); Las llamadas des del 
extranjero están ligadas a costes suplementarios..
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Bresser Iberia 
Servicio al Cliente 
c/Valdemorillo,1 Nave B 
P.I. Ventorro del cano 
28925 Alcorcón Madrid 

España 

 

www.bresser-iberia.es 
 

    @BresserEurope 

 


	Introduction
	General Information
	Safety Instructions
	Chapter 1: 3D printing technology
	Chapter 2: About the 3D Printer
	Chapter 3: Slicing Software
	Chapter 4: Maintenance
	Chapter 5: Warranty and service
	Manual_2010600_Impresora-3D-WiFi-T-REX-2_es_BRESSER_v032021a-outro.pdf
	Introducción
	Información de carácter general
	Instrucciones de seguridad
	Capítulo 1: Tecnología de impresión en 3D
	Capítulo 2: Acerca de la impresora 3D
	Capítulo 3: Software de rebanado
	Capítulo 4: Mantenimiento
	Capítulo 5: Garantía y servicio

	service.pdf
	Einleitung
	Allgemeine Informationen
	Sicherheitshinweise
	Einleitung
	Kapitel 1: 3D- Drucktechnologie
	Kapitel 2: Informationen zum 3D Drucker
	Kapitel 3: Slicing-Software
	Kapitel 4: Wartung
	Kapitel 5: Garantie und Service




